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1 Introduction

SafeFMEA is part of the SafeSuite family of products, a powerful tool for the development
of projects meeting common industry’s safety standards.

SafeFMEA provides a tool for Functional, Process, Quantitative and Qualitative FMEA.
which is a bottom-up deductive analysis method in which failures at component-level
are analyzed in a system approach.

SafeFMEA is specially designed for ISO 26262, ISO 50126 and IEC 61508 derivative
standards.

1.1 Features

- Support for Functional approach, Qualitative, Quantitative, Diagnostic, Safety
(FMEA, FMEDA, FMECA)

- Safety Summary metrics automatic calculation (aimed for ISO 26262).
- Immediate failure rate apportion calculation.

- Imports FIT data value for electronic components from SAFEFIT.

- Export apportion FIT for analysis purposes (SAFETREE).

- Customized Report to PDF.

2 Usage

2.1 Application parts

1. Menu
a. File > (New | Save | Save as| Load | Export| Report | Exit)



b. Settings
i. Items (Main view)
ii. Functions
ii. Diagnostics
iv. Safety Mechanisms
v. Safety Goals
vi. Safety Summary
c. Help > (About | License)
2. Context Panel (Tags)
3. Main view
4. Item view

2.2 Licensing

You cannot use the SAFEFMEA tool without a registered license. “No license” state blocks
the Save, Import, Export features. Loading is still possible for demo purposes but severely
limits the application’s usability.

Your license status can be checked within the "Help > License Management” dialog. The
dialog allows you to update your license, in case this is the first time you enter the
application, or to reconnect to the license server in case the connection has been
disabled.

YR . License Management (TEST) = O x

—  Licenses

| Name Expiration
SafeFMEA 4/10/2026

| Update Licenses | | Reconnect to License Server... |

In normal operation mode the application would reach the server by itself and thus your
active license should appear on the dialog box.

NOTICE: Remember in any case that you will be requested to activate your license through

email after your purchase.
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2.3 License Activation Process (Node Lock)

1. Obtain your license key or invitation email by purchase or contacting
safesuite@cynoss.net

2. Log in to the License Manager through your browser.
3. Authenticate and activate.
4. Install and launch SafeTree, so your node data can be stored by the system.

5. Wait for your license to be assigned by the supervisor.

Now you are ready to use your SafeFMEA.

NOTICE: SafeFMEA licensing system uses the port https 7072 for monitoring purposes. Please

be sure this is available for the application. We beg you to carefully read the EULA
documentation for further details.

2.4 Settings

This menu is aimed at configuring the worksheet.

O Settings X Process / Product: Where the user can select an

specific worksheet,
Worksheet Configuration

v: EVUEESS Product [Component Quantitative]: By selecting this
@® t .
rocue check, the worksheet includes the FIT data value for
Component Quantitative h . i
Diagnostic the component and the apportion of the failure mode.
Safety/Criticality

[] Functional Approach Product [Diagnosticl: Defines a DFMEA andlysis,

FIT Data File including the diagnostics to be applied to any failure

mode.
Import mode
@® Components Product [Safety/Criticality] : Defines a FMECA analysis,
) Fit data

including in the worksheet the safety impact and the

safety mechanisms to be applied.

Functional Approach: Defines the functional approach
for the FMEA analysis. As a result, items belong to a selectable number of functions
to be set on the Context Panel.

| OK | |Cance| |
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Import mode [Components/FIT datal: Defines whether the import is a full
component set from SAFEFIT export or just a FIT values

2.5 Context panel (Tags)

[Tt L B T

Items | Functions | Diagnostics | Safety Mechanisms | Safety Goals | Safety Summary

This panel is composed of several tags, allowing them to define in every case the
contextual data of the analysis.

NOTICE: The Tags appearing on this context menu depend on the settings of your worksheet

2.5.1 Functions

O safeFMEA (CMC.sfmea)
File Settings Help

Items | Functions | Diagnostics | Safety Mechanisms | Safety Goals | Safety Summary

Id Name Description Lambda

0 |IMAGER Imager area 1.3107100000000003E-08
1 |EEPROM |MEM Area 1.0291E-09

2 |LEDS Lighting 2.7987000000000004E-08
3 |LED DRV |Power LED 2.519694999999998E-07
4 |PMIC Power distribution 1.5864000000000002E-08
5 |SERIALIZER |Image pmcessmg| 3.3272340000000004E-08

The definition encompasses an Id, the Function Name and a Description field. The
"Lambda” value is automatically calculated, and it is the sum of the failure rates of the
components involved in the function.
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2.5.2 Diagnostics

O safeFMEA

File Settings Help

ltems | Functions | Diagnostics | Safety Mechanisms | Safety Goals | Safet

Id Mame Mechanism Motification Time Detection Time
0 |DIAGO | SW Req. Polling | 0.001 0.0001
1 |DIAGT |Hardware 1E-05 1E-D6

The Diagnostics list encompasses the following information:

- Identification (Id)

- Name

- Description of the Mechanism.
- Required Notification time.

- Required Detection time.

2.5.3 Safety Mechanisms
O safeFMEA

File Settings Help

ltems | Functions | Diagnostics | Safety Mechanisms | Safety Goals | Safety Sumr

Id Name Mechanism Diagnostic Coverage
0 |5MO | 5SW Req. Polling
1 |5M1  |[Hardware 0.99

The safety mechanism lists include the following information:

- Identification (Id)



-  Name

- Description of the Mechanism.

- Required Notification time.

- Diagnostic Coverage of the safety mechanism.

2.5.4 Safety Goals
@ SafeFMEA

File Settings

ltems

Help

Functions

Diagnostics

Safety Mechanisms

Safety Goals

Safety Summary

Id Name Goal

0 |SGD |The system shall not be activated unintendedly

This is the safety goal description, encompassing:

- Identification (Id)

- Name

- Description of the Goal.

2.5.5 Safety Summary

@ SafeFMEA (CMC.sfmea)
File Settings Help
Items | Functions | Diagnostics | Safety Mechanisms | Safety Goals | Safety Summary
- = [ = — =
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C1000C 0.549| NSR | Open 01| [ L]
C1005C 0.549|SR | Short 0.9 0.04941 None |0 0.4941
C101DR 0.549| NSR | Drift 02| [] ]
C1010C 0.549 | NSR| Open circuit [0.1 | [] L]
C1015C 0.54%|SR |Short 0.7 SM3 |09 0.03843 None |0 0.3843
C102DR 0.549| NSR | Drift 02| [ 1]

The safety summary calculates automatically, according to the given information, the
Single Point FIT for every failure mode at component level.

This sheet allows the expert user to calculate the latent metric point failure. For this is the
result of an analysis this tool is not able to perform it automatically. To do that, the extra
single mode coverage of the LMPF safety mechanism has to be written down as a result
of this analysis.

The final part of the summary covers all the metrics to be calculated by an FMEA.



Metrics
Total Failure Rate 938.2
Total 5afety Failure Rate 190.6

Total Non-5afety Failure Rate 7476
Total Single Point Failure Rate  15.66

Total Latent Failure Rate £3.33
Single Point Faults Metric 91.79 %
Latent Faults Metric 63.8 %

NOTICE: Safety Sumamry Metrics is based on ISO 26262 standard calculations. It won't be

difficult for the expert safety engineer to translate these metrics to the required standard.

2.6 Main View

The main screen offers a compact view of the items and allows to search, and sort by the
columns in the structure (Function, Component....)

@ SeleMER (W toen) SO
e Setwgs_Hep
ems | Funcions | Diagnostcs | Saety Mechanise | Saety Gous | Suety Sumemary

System Efect Severity Occurrence Detection Risk Counter Messunes Obsenvations 1T
PMIC protection iises and no Video Output (Satety mode}|0 o 0 o

[Nose 3
Nore
None

0 o

[PMIC protection arises a0d no Video Output (satety mode) |
None
Nore

8 e i already titered and cear from PMIC output

For detailed information and real worksheet the user must access the Iltem View.
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2.7 ltem View

The Item View is the actual worksheet. We show here the most complex possibility; according to the settings some spaces won't appear.

Identification Quantitative
Function SERIALIZER v Severity 0 Detection 0
Id 162 QOccurrence 0 Risk 0
Name C1065C Diagnostics
Type Name DIAGO
Description Component _
Modes and Effects Mode Ratio 09 tem FIT  0.549 [_] Link Mode FIT  0.49410000000000004
Failure Mode Short Safety/Criticality
Local Effect Mo capacitor output -
| Safety Violat
Block Effect No EMC filtering alety Violation Safety Goal
System Effect high BER.

|| Safety Controlled  Safety Mechanism
SM5 (Serializer Safetymechanisms (CRC, video seguence number..))

Other
Assumntions

The left part of the sheet defines the function involved, the identification of the failure mode and the effects at local, block and system level.

On the right side, the quantitative area allows us to define the risk in terms of numerical Severity, Detection and Occurrence. If diagnostics are
selected, the next step is to select from the previous definition if some diagnostic is used to detect the failure mode.

In terms of component, in the next lines the user sets the FIT value and the mode ratio of the component (e.g. the apportion of the failure mode to
the total FIT). If the component or the FIT values have been imported from SAFEFIT, the “Link"” check should be tagged and the FIT would be selected.

After the FIT value, if FMECA has been selected (safety/critical) the user can select whether or not a safety goal has been violated and state which
one; and to finish the criticality analysis, he can fix a safety mechanism to catch it.

Finally, spaces for assumptions and comments are provided.
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3 Export

By selecting Export, you can generate a CSV file containing the quantitative FIT data of
all the defined failure modes under the “Name" column. This function is aimed at feeding
the SafeTree application with specific data (e.g. 2 component XX + Failure Mode YY ==
FIT). Chek out how to use these values in SafeTree.

4 Reporting
A strong characteristic of SAFEFMEA is the reporting system.

By selecting “Report”, we can determine what parts and components must be printed out
into a report. A multiple selection menu appears which allows the user to define the parts
of the report, and finally to store it as a .PDF file.

File:
® Complete
C Modular

+ Quantitative +/| Diagnostic

Safety Components Only +/| Functional

5 Tips, how to and more

There is a dedicated series of videos prepared to ease your job in our YouTube channel
accessible through our Web Page www.cynoss.net

Nevertheless, do not hesitate to reach us at support@cynoss.net if you have any query.

Remember that technical webinars are periodically scheduled by our technical team. We
encourage you to log in to our user's community to keep in touch with the development
team.

Explore additional tutorials, walkthroughs, and updates on our channel.

6 FAQs

check www.cynoss.net


http://www.cynoss.net/
mailto:support@cynoss.net
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What does “node-locked” mean?
You license is tied to a computer. So far SafeSuite licenses operate this way.

Can | transfer a license to another machine?
You can do it under request maximum 4 times

Is SafeFIT only an on-premised software?
Yes, so far it is. Being such a specific tool, it is easier for us to manage. Let us know if
you'd like to have a cloud version.

Is there a free trial available?
Sure! Just ask as by clicking on the "Free Trial” button on the web page

Is there a usage limitation in the EULA?
You should have downloaded the document in the same package.

Do you offer academic or startup discounts?
We offer students fee. Willing to hear from you... just contact us.

Is technical support included in the license fee?

We have a complete set of documentation, including videos and shorts in YouTube.
Nevertheless, if you miss something just contact support@cynoss.net. Specific training
and hot line support do have a price.

Can | import my excel data?
You can import your data file in CSV format, by using the same output that generates
SAFEFIT.

Just set by this name the DesignatorfFIT|Description[Type. That should work. Just copy
this format.

But are you sure it isn't it easy to use SAFEFIT directly? Ask us for a complementary
license.

Designator FIT Description Type
R100 0,4801 RES-3-K-ohm-5%--50-mW-0603 (mm), 0201 (inches)- 11.1
C100 0,549 CAP-100-nF-10%--50-V-1005 (mm), 0402 (inches)- 10.2
CAP-1-uF-10%-X7R-25-V-1608 (mm), 0603 (inches)-
C503 0,549 GCM188R71E105KA64D 10.2
D400 25,71 DI-PMEG4020ER 8.2.4
L202 3 IND-1-uH-20%--3.5-A-OTHER- 12.3
L400 3 IND-4.7-uH-20%--2.8-A-3226 (mm), 1210 (inches)- 12.3
Q401 37,29 TRT-60-V-0.3--210-mA-SOT-23 (SC-59, TO-236-3)- 8.(4]5).5
Q403 101,3 TRT--40-V-N/A---10-A-OTHER- 8.(415).5

U100 48,4 Serializer MAX96717
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U200 3,68 PMIC MPQ7928
J100 10,98 CON-1-Pin Number-N/A--1-A-OTHER- 16.3

Can | change the company logo on the report?
You can name it as you wish. Once the final integration in the toolchain is finished, we
will release this feature for you.



